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Defaults (Al ) ) dale 4l o) Al gl cilalas) oo gl Jual) Adi (LSay ull) Claag
1) 2 sigal) Jra IS Grid ASidy ans ) Aalsa byl Mia Lia )i g8 el ) Lgmuda sidy
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EEspecity next poinc or [Close/imdo]:
Specliy next poilnc or [Clode/Undo]:

_ Command: 5
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».aet R EMNEE E= NS
il g A Jardl 2y an )l) dabiss (6-4) JS4
S g clalae) (o Craaii ¥ ) el jull Anida) i) Adally 5 i0ad) 5 Jabatal) a2
) i Lagun say Sy (LSl g pdipal) Jag il Liaji 13) Lgaa ifisll o) Laas g Al
 (7-4) JS& B Aiual) Aagall B Hgdad (awa ) Cldlae]) JUAS Leta g D JLOAY) Aaild
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) CINASY) (3D Lan y a3 LS ADES Huuial) aiitunal) BaY &), Rectangular snap
Lol ALY L Lasalis

i PR R

| ¥ Drafting Seftings

Sriap and Grid | Poler Tracking | Object Snap | Dpnemic Input | Buick Piapeties.

[+] Snap On F9) [¥] Giid On (F7)
Shap spacinp Grid apacing

Snep i spacihg; 1 ‘ Riid ¥ spacihg {W
Snap ¥ spachg; U Gid 'Y spacihg a

[“] Equa ¥ ard ¥ spacing afor ine evens 5 -
Palai spacing Girid babhavice
Pdar ditances ] J'-’l.dil:lil.fE guid
[] Alows zubrivicion balow grid
Shap type apacirg
{® Grid enap ; . !
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O g E:i [] Folaw Diynamic UCS
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) Pu: moda. When the enap type & set to Grid enap and Snap mede is on, the
ouracr anaps to o rectangular snap grid. (SNAPSTYL systern vanable)
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i gl g ASd) Culalae) 338 (7-4)J8d

62
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AL Ao Lgild o) U Sd ) G 30 phal) ¢a LS Ui g sl al JAS 3ol Y1 o (3
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3IAl (19Sa (e il gSa Eufaain Fuadl) aladiv) -5-4
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| Snap and Grid [ Polar Tracking Obiect Snap ‘ Dynamic Input | Quick -Fmperties]

Chjoct Srap On (F2) [7] Object Smap Tracking On (F11)
Obect Snap modes

Endpairt
Midpcirt
[¥] Center
Node
Quadmnt

Irserton | Select All

Perpendicular Clear All |

Tangent

[7] Nearest

M d F &

S = O = 0O

Apparent ntersecton

B Irtersection
- |¥| BExtension

[#] Paraliz!

command. Atracking vector appears when you move the cursar.

f é) To track from an Osnap point, pause cver the poinl whie ina
To stop tmcking, pause over the point agan.
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@ TexHt Style

Current test style: styled
Styles:
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Command: _cylinder
Specify center point of base or [3P/2P/Ttr/Elliptical]:

(27-7) Jsa
Al Al 3S ya gl Al ghaudl) pLEI ) 2aa

Specify height or [2Point/Axis endpoint]:

G8Ss Gy D) ghul) oy (0 endpoint Al gl 38 5e LA aladia) e G<ayg
XY (s sl ) Apaadlly Sila W ) gaa

Aol e W laidl AU Elliptical Jlisid 4 iy sas\al) ¢ 583 of Lyl 13) L
-1 by Lasasd B 364 Al

L yanl) JSAl J 4V ) gaall Ailgs Adabie

A Ay Ak

(e yanl) Jedll SN ) gaal) Jghe

_z.'ﬂ‘gh«.u‘ﬂ &Li:u].

d g Al sl (C

S 2 ) gl (8 LaS Saclil) o1a g 4y guan gl A ila Basld il g A an s LAY

(28-7 ) s Bay 1AV @l ghil) aili XY (g gisal)
Command: _cone
Specify center point of base or [3P/2P/Ttr/Elliptical]: .33\l jS ja saa
Specify base radius or [Diameter]: Ao ki gl Baslal) jlad Chual saa

Specify height or [2Point/Axis endpoint/Top radius]:
Command: Specify opposite corner:
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(28-7 )Jsa
Al ghau¥) pa Liled LS paiedy oY) Al ) (e @ JUAI8 4 gy SaclBl) (<5 () L) 1305

8 S el (2
hi g XY (g simal) ) 4550 5a Lgad 2 pal) Jagdad 5809 5 0 p LY el 112 padisy
-1 AW ol shal) Cua ¥ Ay g cciliiaay) AU 7 jeaall o Guali ) saa
(29-7 ) Jsid) dBaadla pa
Command: _sphere
Specify center point or [3P/2P/Ttr]:

BSY) 38 e Adad) aaa
L
27N (
/‘* 5 "‘H"

i,i S

Specify radius or [Diameter]:
BSl) el g jhd Lhad daa
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aud) sl (-5
5(3) O Tl il gad) (e dae il ¢ (30-7) IS ¢ b pLETY 1Y) 138 addiey
-1 AN i ghadll o jaY) dilg ¢ (32)

(30-7) s
Command: _pyramid
4 sides Circumscribed
Specify center point of base or [Edge/Sides]:
Bas LAl 38 ya AdadS JA)
Specify base radius or [Inscribed]:
SR G Baslil) £MaY Aulal) 3 ilall jladl) o) hall) Chuad A0
Specify height or [2Point/Axis endpoint/Top radius]:
audd) gl Jaa)
as Al Alu ) 223 Top radius saida 4 g t JAak o gLl (Sad aBll) a ¢d) Ll
ad) BLE JB) ) pal g JAlAl e Lilad) Baclal) pOLLY dudall 5 dlall jhail) o) pladll Chaal JA)

Ciay) £ L) (9
S mnsg XY (sl ¢5) 55 asaeld ¢ (31-7) JSd o) p LAY aY) 138 ariiioy
cZ sl () Sl O LA ) O g ¢ JHlal) prlaadl JBaN) ¢S ) s sauaad Al s M) JgY)
-1 ALY ) ghadl) Cavs aY) MLy

(31-7) Js&
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Command: _wedge

Y AT ey
Specify first corner or [Center]:
. O] BaslAl ¥ (0S 1 Adals JUaa) A g¥) Al ) caldas
Specify other corner or [Cube/Length]:
C B O, JUA) calhas A0 Al M)
Specify height or [2Point]:
L Sl B ) (g gt A () B LS ) JAT) il
-1 O eyl (5 AT @l LA
S0 AN Gl pa ) aliad ) Al 229 Center saida 29 C LAY o -
Specify center: . S all yaad qullai Al gl g ASacld
e gal) 4 glasiia Al g (195 Sy (i) aa )l Cube AUl Allu ) LA LIS a4
Specify Length: Jhll JUA) dulua AL18 Alle )
U9 iy Jahl) JBab Cpdul) sl Length Al Al d) jLd s o4 -

ARl L&) (5

(32-7) Js&

=1 ALY ) ghdl) a8 bl JUaY AAIAN Cop¥) Andy Al s pLEN
L ARIAY) S pe ddaBl a3 1

L ABIaY) a8 Chal das 2

. Qo) b Chal a3

Al i) 7 ghauad) g 2a) gl £L) 2-5-7
Gkl aladily daglaa dpwaia Gl gSa dra dagt) AENEN han) g dal gadl pLES) (Say g LaS
-1 (33-7) Jsdl (A (e Las Ribbon (s A1 Ja sl (e Ll Jgea sl (S (Al g 4L
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@ Sweep

(33-7) Js&
O Jasa J3A Aa) JY il gSall ((350) 2a
Sweeping objects along a path
Agid ade gl aliius jlua Ao (485) saa Ciadg (Polyline) Yis | uaic i ¢
Ayl apaady Sl 0950 Of (San g aibaily saaty adioial) Jlawall g ¢ Sad) 2N aus g o
. taper angle ¢l
Ay Ol (6 o] A gl adSd ilad) JSAY) (S g Lal) i) s gal) 3l
) Al gk (Extrude) (g sa¥) il dli sy ¢ (34-7) Je

W= o

U [' ) Poiyrois (i B oo - HDe B
Bos  Extrude £ Presspul Smooth 8 oxE. M 0880 B

' $ onect @ @ - OO0 9@ AR £E&
Moty -

Meih = SoldEdting = | Draw =

(34-7) Js&
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Select objects to extrude:

AU Al Al 1 pgdish Enter glide bl af Lgihs Giglhaall adlad) JS&) palic 4
L) S ) yaas
:Specify height of extrusion or [Direction/Path/Taper angle
. Enter & (@ gl ) cucis
aaad ol B 3500 (dla Ay g ) Aad ayaad cand A4l Al ) (4 Direction <580 131y
_Lg.‘i:g A _gall paliall U‘b g‘g‘gh.“ (MSJ:IHH-“ & ‘90 @.a'l.bg.“ i 3«.1*_91}“
Al lhy ) jlwa 098 O sthall paial) LA b Path S AN JLAD) @ as) 1) L
-1 A Alle 8 Agladi) Al ¢ (35-7 ) Jsdi
Select extrusion path or [ Taper angle ]:
OBl Ay g5 aad ) pliad o dlliyg
Taper angle

Dmars.n  BEEEECEE Tty W R o) ol |

(35-7) J&
abliall G Lofting (2bowdV) 2al) =
Aty (lad¥) By ) oy V) BATE (5 Cpabila S e ) JOA (a s pauy (S
5 i gad) Ukd) daas dda g dia ddgla Ja ) sl Diad Cuza ) gaa Job o g adaliall 02 G La

) LdE a3 Enter kil o i g4l oda daadg Loft s JUAS a8 Ja )l Jeb Jiay ) jlesal)
. (36-7) JSal i Les
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Dynamaic/Extents/Previcus/Scale/Window/Object] <real time>: e

| R P R e TR

36-7) Js
slaiel Uiy el 138 aladiud G AT G ,Lf.i &L_G!)M oo duda ll adaliall (o Liage
Polyline aladials ol sy diada S Jay pel Siad dga gall Cliiaiall of @l L) Lo
) JLaS g A8 Jahal) o Jadll Algil) Adaki 3 (5 Al g Jadll Aglad) AdakS 3 5 00w i
. (37-7) & ¢ o) 3 el Jlosal) o (1) 2383 Loft

T = e R P e o = Ll

(37-7) Jsa
-;‘E,SL__ LaS Y L83 ) ghad g
Command: Loft
Select cross sections in lofting order: 1 found
Select cross sections in lofting order: 1 found, 2 total
Select cross sections in lofting order:
=AY Al it ey Aud jal) adalial) 3aa

116



Enter an option [Guides / Path / Cross section only ]J< Cross
section only>:

(bl Az o adalia ¢ jlusa ¢ Clgaa ) loOfting el Aleu g ayaail A8y pha gali ) callay
Clae) Jlga e Wasy 4B Cross section only ki dus e aklia U jd) Ua g
. (38-7) Jsdc xal)

' 1 i
- =)

Surface control at cross sections ‘

() Ruled ‘

@ Smooth Fit

() Normal to: | ‘

All cross sections

(") Draft angles
Start angle: Start magnitude:
Q0 0
End angle: End _magnitude: |
80 0
| Close surface or solid
Preview changes

o

(38-7) Js&
ol aalal) pLii) ald (OK (381.54) AL Latny g Wl Jand A Alal) (335 clalaey) basda aid
dad)

Revolving objects around an axis s Js» 7 shedly Sllsl) o8 =

-1 ASY) ) 5aY) A8 ra g sa¥) 2T U8

13 Ll ¢ Solid dua pna (Ao Jguanl) aly Gara jsaa o $ia (9% pgaisic o
. Surface ghw gl 0 sSh 7 gida & gSal y gail)

alg o o CusSa m ST sk 0Se @

Qs Polyline b A G gSall Jo gad caand (ol 98] g Lhaghad aday (1980 pygaiaic o
Ladas gl ¢y g W) 9 Lol Lo il
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Ay Sy AT s gl dga oI ZY, X AN gl e ) dgs astil) £)2) OSay e
(39-7) 84 BaY ¢ 0 55 31 yal ¢y gSall JLAAL g oy
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""I \A =y
; " Y Joa pagil mEe
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JEAL ) La jgaa Jtdly y gail) @il
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(39-7) Jsa
Juaia 3 guae JCd o ddg e Apndid AL o 5L Lghaeld B paiaie A glo iyl 1Y) Al (S g
54 e ddady dlall o ala¥) Bl o A0 glal) a1 A0Y) <) plad) 38 g Aa AN
-: (40-7) Js&ll B Las o) 9l

e s e B

(40-7) Jsa
. Draw > Modeling > Revolve A e Y 35 (1
Enter ki) o W 98 3l jal) ciliglall 530 (2
- Ol Jsaa A (3
L Olosal) Agg 3 Jay (4
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Slicing a clawaall g iy Jla duld jl) 7 ghauadl g 2a) gl sLAY (5 A1 (3 ok i g
Slice Lgalad (o rhad ol Claaa ) dlacd) cd 4 ghecal) il <all Jusals 5l solids

Jlia
-1 il L gl ¢ (41-7) JSAD) pu

(41-7) Jes
(17-7) J&) b L LS Isometric snap b -1
solaall g JS a1 8N Jdige JS& i S F5 glida i) i Ortho el bl -2
. % Isoplane Top &Y ;s gimall 8
. (42-7) J8&) A LS o 60 028 9 120 Jgk Jibiiss ai )l Polyline al psiicd -3
AV Agall ) 4diiy 2.5 Gae s 60 Jsky AT S il Y 2 is i 4l -4
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Grbeal) AN B e LS i) Joliisall (e 40 ABlus o Lgaiai g 4de 43 Al -5

72.5 Jsh i sl) Jebiianall g (5 punsl) ABlad) Cpay (a bl ABaLal) (b AT Sibiiena aus i o3 -6
L& e 60 5 Yok 115 (ably 328l Jlay AT Juass aus i a5 60 28 3

Cra JUEAS g Jalatal) pLES ) a3aa5 (4 31 Properties () caliy Jg¥) Jalaial) aaas o .7
dad puad af (72) (A L i (0) Aaidl) 4alal 2239 Elevation ¥ pailail) 4.l
0584 (12.5) (A (gl adal ) i g (36) (Al (sl il g (10) ) Bl plis )
(43 - 7) Jsah Ly

(43 - 7) Js&
S 5 Aua A1) olaily adli i Enter ki o Gilal) iy Extrude saY¥) JUds did sy -8
da jill 3aaig Extrude Jidd af qugdhaal) gL ¥ A cuedlad) 35 23 Enter a5 (72)
o) ) Lghlisd) s (2.5) i oY) oladlyg Enter iy glilly sl i g
Lisgil a8 ¢4 (59.5) uisiy GUN) dales dgle ), ol adaldl) Load By oo gthaal)
(44 — 7) Jsdd) il sl
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(o @ ? Gagde o BT ; - 18 L (210 MWt - |@ B ¢ B2swasss
S 8oua: /0 BO0RG. V. B-le b A Gawneme + fEE ST | esmied Ly S
- o @ @ @000 ©- F AR LE | e B D - - = R [ |
Xawing ~ g Dr o cechion o Subbjer Layen ~ i
i
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Jed) Wl ¢ 55 Realistic Lie JUdS g View ) qadi 3D hai Jsil) slhe) (o 4ly -9
Y QY sda oY elld g Apniall LSS Aad) glf uas Y ARy ) 038 () ol L 5 (45 — 7)

FASITS, B16540. 0.0000

(45-7) Jsa

pay LiiSey 13 maial) Jill Front , left Right iluall JLSa) e gy pSatl) o2y
A g JSA) a i Alad) 43, 5kl Guily g ISOmetric Snap s g Ja)

P - T M e s

S RiErAcE™
|52 o A
Draw = I

"I CP QPETeT M oW ¢ D328,

(46 — 7)Js<
. (46 — 7)Js& A Lalal Lol g (580 (5 i Aladd) adll) (s (GESYY Jand g cileLis Y)Y
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Composite Solids 45 all 7 shull y Clawaall sl 3-5-7
Intersect ahlii) s Subtract zo&l s} Union geslls ddawy ddhia cllay
A dsa sl GSang ¢ 1agiad JAS] Claaa L) (S Cpiilud) o 881 8 Ll 83 A da) sad) O
sl gl pad ol a5 Home sl o Ribbon i sl (e Agilaial) cililaad) il gl
(47-T) Js2l i s Sold Editing

‘ N | AutoCAD 2010 Drawing
- @ Mesh Modeling Render Insert  Annotate  View Mar

D @ Polysolid D 80§D o
{23’ Planar Surface @‘@ &9' "‘J n,f'F 8) &

Box Jloft | Smocth : =
v * (L Press/Pull | Opject O @em- OO &-
Meodeling * - Mesh _=_htalid Editi... ¥ | Draw v
(47-7) J<&

Union gsbull g salgall aa g8 ol gad jal - o
- b LaSe (48 -7) JS& ¢ 1aa) g Law gaall oY) 13 ¢ ghaead) g e o) e
- A Al ¢ld Ribbon kiydll e @) s Lghi e
Command: _ Union

Select objects:
JEEAY) Alee 2l Enter JAaY) il & Lgaas iglhaal) dalsal) i) e

=1 b La ) oL Liayi agag
« Rectangle, Circle, Line s jal ¥ 4agoupal) Lpciaigl) JICEY)

£ ) G (8l (S ¢ (49-7) JS& ¢« Region <) aliiuls aal g agu GHS ) Lgligas
Lol g el cliles
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3 0A A0 Asa gyl LIIKT)

(49-7) Js
L 0 jaaal (Say Ad) 98 da g (oagauy (HIS ) Adygal e g Al gad J8 JSA) G (30800

138 (g galll dllaal) b ) Joadl) s
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Q855 O Sy Jo Al Lgaad 31 all 7 ghaal) g el gl (953 ) B gl pusd  m

ol Ypmny (5L
(@ ibtract zsbulls salsall gk jal
gLl dlldy ((50-7) JSd < pAT b gl poritna (a gedins g i A1) (S ) 13g

145y &) ghadl)
([) ¢ sl Adghy) Al <+

JHEAY) LY Enter Jiaa) kil of 4da gkl 3 jal) aed) LSS +

Subtraction gkl =

(50-7) Js&

14T eLgY Enter Juia) il ol Lga jh ) jall alea¥) gl auadl [LuaS -
Y
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Wz (2 Region ¥l sLddal) (ghlid) 7 s (Say Adld ¢ (49-7) JSd ¢ Lidla Lasy
. (51-7) Jsdi ¢ baaa dihaia o Jguaall

™ * qes w3 1 v
/ﬁ \7Um14._m,._.,s.;u&t

(51-7) Js&
(T Intersect rshwlls dalsaldl ahals jaf
((52-7) JSd lagdn & jidial) (5 Cpamind) (pa adaliial) ¢ 5ol Jad By a¥) 138 LD aay
-4V il ghadl) ai ) 1ia Adiil
LD bl ) Aighy) Al

Lagadaldl 3) yal) el jUdie
L idal) aal) ZUG) g JLEAY) sy Enter JWa) i o @

(2) amaad 0o 852 |
(1) puad) 2 JAN ]

(52-7) Js

Cra S p ) (B LS (e guda gal) 3 S g Jag Al Ao adalil g = jlall g gadl) jal ) 345 (1) JLs
(53-7) Js&ll B cpadl dga

Draw>Modeling>Cone &ailall jii)

120 Asli )5 80 g il b Ciaaig( -260,160 ) i S pal) s J3
Draw>Modeling>sphere 4aildl i)

60 580 b Ciual ( -260,160,80 ) 4 IS yall Ak Ja

) g &L da g Al g 8 S o)

Modify>Solid Editing>Union i) i
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4N BaY g cEnter JWaY) ) ki) 45 5 SN g kg aall 53
Modify>Solid Editing>Subtract aial) ji| =

Enter JAsy) Jj i) a5 400N dauil) A hg aall ji)

U BaY g « Enter JAaY) ) diuda) o3 4000 Al 58N ga) w
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—
LA5 any L35 ey mSUN A day S S
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wusdl) e Extrude sl i o
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Jasadl e Extrude ¥ 3
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i Scalelist.
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[ TableStybe..
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"% Multiline Style..

BB Unets.

& Thickness
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1
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PYC White

a
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FinashCarpentry Wood ..
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Sets the number of decimal places or fractional size disj
linear measurements,

Units for specifying the intensity of lighting:
| Intemational v

[ ok ]| cancel || Drection..
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e AL el Jahal) LIRS <) gaY) oy i (e i View Aadld o 8L a il Taig
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